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Introduction to AECOM Team

— Richard Kaselow — Devin Boyce — Avilene Rodriguez
 Associate Vice  Senior Project » K-12 Facilities
President Manager Planner
o Asset Management o Asset Management o Asset Management
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Overview

— Asset Management

— How Energy fits into the equation
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DeSign LeSSOHS Learned — Include energy saving systems and design techniques in the

district design guidelines, RFP’s and design contracts.

» These systems are not to impact the overall construction cost.
_ This would be for MEP and for general building design.
— Have the district create a position for a champion for energy
savings
» This person would be responsible for design and construction
review to insure all projects meet the energy savings goal
— Design new buildings to be renewable energy ready

» This could allow for ease of adopting renewable energy in the
future

— Have school districts make energy saving part of their
curriculum, to make all users (teachers, students, and
parents) aware of energy saving strategies

» Create districtwide competitions for energy savings, reduced
waste, etc.

— Put students in charge of monitoring energy savings and
allow them to hold the school and district accountable

— Incorporate renewable energy!!

4 CASDEM A=COM



AECOM Energy Audits

— Qverall Process
« Coordination and Vision
o Client-driven
o Stakeholder investment
« Site Audits
 Facility Condition Assessments
« Site Energy Use Modeling
« Economic Analysis
o Energy savings
o Capital cost
oLife cycle cost

* Incentive Procurement

5 CASDEM A=COM



Innovative Energy Management Systems

 Utilities Privatization

o Fixed payments for maintenance and
capital replacement

o Regulated or unregulated
o Electric
o Gas
» Partnerships
o Energy providers
« Community Hub
o Clustered users

6 Presentation Title A=ZCOM



Case Study — Advances in Energy Storage and Alternative Project Delivery Models
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Case Study — Advances in Energy Storage and Alternative Project Delivery Models
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Case Study — Advances in Energy Storage and Alternative Project Delivery Models
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Case Study — Advances in Energy Storage and Alternative Project Delivery Models
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Case Study — Advances in Energy Storage and Alternative Project Delivery Models
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Case Study — Advances in Energy Storage and Alternative Project Delivery Models
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Case Study — Advances in Energy Storage and Alternative Project Delivery Models

Allocation of Risk — BESS in peak-shaving use case 8

Risk

ESCO

Government

Demand rate

Accepts reasonable escalation rate for demand
charges.

Assumes manageable risk which is
commen and recommended
approach in ESPC contracts.

Non-price change to tariff

Assumes manageable risk.

Load anomaly/grid performance

Compiles robust performance/context data 10T
perform forensic analysis and support proposed
M&V adjustments, if necessary.

Assumes risk.

Load profile change

Continuously “trains” control system. Characterizes
variability of benchmark profile IOT make M&V
adjustments.

Assumes manageable risk.

Weather

Implements cost-effective measures to adapt
control strategy to possibility of adverse cloud
cover.

Assumes risk.

B BESS performance

Assumes manageable risk for battery system
power and capacity, and for control system
effectiveness.

Assumes risk of availability of
savings, consistent with risks
stated above.

3% Risk inherent Risk marginal ® Risk shared

13 CASDEM

AZCOM



Energy and Learning Environment

— Classroom Lighting

» Natural light is shown to benefit the health, concentration,
and even test scores of students

 Alternative solutions such as daylight bulbs and tubes can
be implemented to create the sensation and benefits of
natural lighting as accurately as possible

— Bad Lighting

» Leads to discomfort and hyperactivity

» Teachers effectiveness




Proper Temperature and Control

— The ideal temperature range for
effective learning in reading and in
mathematics is between 68 and 74
degrees.

— Teachers need to be able to control
the temperature in their own
classroom

Air Quality

— Poor indoor air quality is a major
contributor to absenteeism

— Indoor pollutants: office equipment,
flooring materials, paints, adhesives,
cleaning products, pesticides, and
insects

15



How to get Involved

Organizations Events
— Colorado Renewal Energy Society — Green Schools Summit
» Calendar with ongoing events and — Rocky Mountain Green Conference
workshops | —The Alliance Center — environment
—Women in Sustainable Energy — series
WISE

— Sustainability Expo

— New Energy Colorado _ _
— Climate Leadership Conference

* Colorado’s solar & environmental
communities that serves as an
umbrella for several educational
programs

— USGBC Colorado
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Q&A ENERGY E'FFIC[ENCY

IN SCHOOLS

1. How do you achieve energy savings
on new construction?

2. How do you achieve energy savings
on existing construction?

3. What are the more typical energy
saving projects?

4. What are the more innovative
energy saving projects?

AZCOM







Preliminary Metrics for Energy
Audits

Steve Doty PE / CEM
Energy Engineer
2018



Agenda

Metrics
» Part 1 — Why Metrics and Why Preliminary?

» Part 2 — Annual Use and Benchmarking
» Part 3 — Monthly and Daily Data
» Part 4 - Interval Data

» Part 5 — Case Examples



Part 1 - Why Metrics and
Why Preliminary?



Why Metrics and Why

s»*Information from Data Preliminary

- Get to know the building before
wandering around

- Compare to similar buildings
and uses

- Compare what you see to what
you expect

- Patterns, or lack of patterns

— Leads to Qs and ECMs



Why Metrics and Why
Preliminary

'»Better Results
- Adds focus in the field work

- Look-for items, in addition to all the wandering
around

— Where to start. Where not to start. Clues.
Questions. Things not to miss

- Can establish a rough value of achievable savings
(energy or demand)



Why Metrics and Why
Preliminary

eStart to Tune In

- Is use for this type/size building normal or not?
- Extent of weather dependence?

- Usage follow building hours?

-~ Persistent use after-hours?

— Ghost loads?

- Randomness?

- Poor load factor?

- Low power factor?

- Moving between rates?




Part 2 — Annual

use and
Benchmarking



Annual Use and Benchmarking
¢ A Sanity Check
- “Compared to....” similar use
- EUI (energy use intensity)
- kBtu/SF-year
- CBECs-2012, PBA (principal building activity)
- Blending PBAs is OK, proportion by area

- Rough idea of achievable potential energy
savings, multiplying the overage by building SF
- (Gray: don’t know at this point if it is electric or gas)



Energy Use Per Student Energy Cost per Million
Gallons of Water
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*Internal Benchmarks can make sense

- More clues...

Annual Use and
— kBtu or $3 per student-year Benchmarking
— kBtu or $$ per meal-year
— kBtu or $$ per hotel night-year

- per million gallons treated water, per widget, per
pound of steel, per ton of gravel, etc. as appropriate |



ual
s*Control boundary concept Annar?duse

G ) Benchmarkin
- Account for energy used ‘inside the box’. ?

Source: Univ. of Colorado,
Colorado Springs, Energy 10
Engineering, EN5080



Part 3 — Monthly
and Daily Data

Daily Gas Use vs. Weather
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. Monthly and Daily Data
» Monthly

- Energy use vs. degree-days
« Accuracy improved if building balance temp. is known

- Energy use vs. occupancy
- Energy use vs. production (part load inefficiency)

- First good indicator of weather dependence or lack of it
(if energy follows degree-days)

¢ Daily
- Confirms if set back controls are functioning
- If gas is used for heating, and setback is working,

correlation of gas use to degree-days will be weak.

(prior slide shows this) .


Presenter
Presentation Notes
Balance temp:   equilibrium between envelope loss and internal heat gain.  Higher internal heat -> lower balance.  Worse insulation -> higher balance.  Typ range 45-65


Monthly and Daily Data
** Production and Internal Metrics

Variance in utility cost per unit of production by month
indicates lack of load-following energy use

- Not turning things off
B Part |Oad |OSS€S Specific Energy Use for Production

- Oversized equipment

150

100

50
s [t Bt U per pound of metal

Why?

kBtu per Ib of metal

- May be unavoidable
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Part 4 —
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* Interval Interval Data
- Usually electric only
- 5-15-60 minute

¢ Good applications
- Correlate ‘when’ something happened
- Prompts useful questions: ‘what is that?’
- Shows daily patterns, rhythms
- Defines ghost loads (residual use, building unoccupied)

¢ Limitations
- Not good for weather correlation (ENE response lags)
- Can lead us astray if the day picked has some anomaléy




Part 5 — Case Examples

16



Case
Examples

Not all metric reviews are as dramatic as these samples.
The method is the same as any troubleshooting:

Know the system involved, and what you expect to see.
Compare it to what you actually see
Start asking questions

“Doing the homework” before surveying the site makes
the work more focused and usually brings better results.

17



Case
Examples

Normal

Gas is practically zero all summer, just some domestic

hot water. Electricity is flat (lights, computers,
appliances), with a hump in summer for cooling

18




Case

i : E I
Gas/ Electric Consumption xamples
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VAV box minimum air flow settings too high and
boiler left on

Hot water reheat. Note the gas use does not come
down in summer. 19




Daily Gas Use vs. Weather
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Lack of setback control

Gas use follows degree-day demand in the week,
normal.

Gas use response on weekend should be less from
reset, but it isn't. (Shaded bars are weekend)
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Case
Examples

[T ]

Multi-zone false loading from blending

Random. Same gas usage response on days with
much different weather, which makes no sense with

gas used only for heating. o




Normal response for gas heat
Strong correlation to weather

Case
Examples

22



Case
Examples

Broken controls

Note the randomness. Hand-operated control valves,
boiler was started manually, sometimes forgot to turn it
off. Weather independent usage (bottom) is kitchen

23
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Case
Examples

Control schedule error

Building is closed weekends, but the controls are
keeping things running anyway. This is summer A/C

Green bars are occupied time

24



300 Case
Examples
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Ghost load

Unidentified load in the middle of the night, building
closed. These loads are invisible without interval data
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ick Case
Examples

VAV minimums set to 100%

“Trend lines” were used to get past noise. Pointed to “energy
use lowest when cooling demand is highest” which is the
signature of constant volume reheat, which the VAV system
became from changing the settings. Green is approx savings




Case
Defect Examples

Troubleshooting

Envelope improvements for high gas use. Then energy use
goes up instead of down. Which makes no sense.

Defective control caused cooling to run, false loading the
heating response




Thank You

Preliminary Metrics for Energy Audits

Questions / Comments
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CASDEM MEETING

May 10, 2018
School District 11




Overview of School District 11:

Founded in 1872

72 Square Miles

26,665 students

46 Schools (5HS, 9MS, 32 ES)
3,903,954 Square Feet

~ $5 Million annual utility outlay




District 11 Energy Program Overview

m Program initiated in the late 1990s
m Active until 2012
m Program gap from 2012-2016

m 2016-2018:

— Investigated the history of District 11 Energy
Management Program

- Determined status of the industry as a whole

- Conducted pilot projects to determine viable
strategies for water/energy management

- Developed new goals and vision for this program




The
History of
Our
Program:







Recent Program Activity:




Recent Program Activity Continued:




Developing Goals & Vision:

m Market Research

m Input from The Energy
Advisory Committee
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The Future of Our Program:



Discussion:

Energy Management Sustainability
« Cost avoidance is * Carbon footprint
the driver  Waste diversion

e @Green product purchasing
* Alternative fuel vehicles
« Staff/student engagement



Building Envelope
and
Mechanical Insulation
Energy Conservation Measures

Thursday May 10, 2018

Peter Boland, CIEA, BPI, LEED GA
Energy Conservation Specialist
|-Star Energy Solutions



BUILDING ENVELOPE

The building envelope is the physical separator
between the interior and exterior of a building.

Components of the envelope are typically:
* Walls

* Floors

* Roofs

* Fenestrations - Windows

* Doors




Is The Building Envelope Important?

“In Commercial and Residential
buildings, 42 percent of energy is
lost through the building
envelope”

Former Energy Secretary Steven Chu



Building Envelope Energy Losses

Air Infiltration/Exfiltration
Mitigated by
Air Barriers & Sealant and Weather-Stripping

Radiation & Conduction
Mitigated by

Insulation & Thermal Breaks



WIND LOAD

Positive
Pressure

Negative
Pressure




STACK EFFECT

And Ejected at the Roof

Air is drawn in at the
Floor




How is Air Leakage Measured?

ASHRAE 90.1 Crack Method - visually measuring cracks and openings in
the envelope and calculating the amount of air moving through the
cumulative opening

Blower Door Testing — using negative pressure to increase the visibility
of leakage sources and measuring the actual amount of air entering
through those sources



Blower Door Testing



Infrared analysis can identify air leakage
and missing insulation



Air leakage under slight negative pressure



Wall penetrations — Some not so bad



Wall penetrations — Some very bad



Wall cracks — Some are superficial



Wall cracks — Some not so superficial



Wall openings




Walls — air infiltration at floor interface



Walls — Thermal bridging



Floors

Missing Insulation Air Leakage




Roofs

. : Roof hatches often leak
Missing Insulation



Roof — Infiltration at roof wall




Soffit — Exfi\tratio

Hot Climate



Roof — Campus IR image of roof issues



Doors



Light is not a recognized method

But a very good indicator of Energy Savings Opportunities




Door Leakage — Some Obvious

Missing weather-stripping



Door Leakage — Some not so Obvious




DOOrs — Ineffective weather-stripping

Hot Climate



DOOrS — Effective weather-stripping

Before repair After repair



What do you think?




Fenestrations



Replacing Windows Challenges

In a study completed for Concord Municipal Light
in the Boston area, it was determined that
replacing 15 old windows would save $42 to $112
per year. Even at that higher number, it would
take more than 62 years' worth of energy savings
to pay for $7,000 worth of windows.



Windows can be in poor condition but rarely
fit into an energy project budget




Window inserts can be very cost effective and
energy efficient



What Defines a Good Opportunity?



Are the Buildings Old?
Historical?

In Overall Poor Condition?



CAN YOU SEE DAYLIGHT?
There is Opportunity




Comprehensive Building

DAP Premium Polyursthane Concrete & Masonry Sealant #18814 0yrs minimurm 25 years www.dap.com E n V e I O e R e O rt S
3 M Polyurethane Sealant #335 n'a minimurm 25 years http://solutions.3m.com

TremSeal D One Compenent Palyursthane Sealant Tyr minimum 23 years hitp://www.tremecosealants.com
05 Enhanced Palyursthane Sealant Tyr minimum 25 years http wi.05ipro.com
w Coming 7 i 50w i E v vww.doweorni
Dow Coming 790 S\I\co.ne Building Sealant : S0yrs nwmum 25 years http ,\,\,.dc..,ccrmg‘tm? Do e
GE SCS200 SilPruf Silicone Sealant and Adhesive na minimurm 20 years http siliconeforbuilding.com Door Doar
Boss 312 RTV Industrial Silicone Sealant Tyr minimum 20 years http wi.accumetricinc.com Weather-  Door ~ Sweep- Door  #of #of
Sikaflex?- 1a 1\1,[ minimum 25 years sika.com Length  Height  SealantRequired stripping Sweeps Crack  Astragal Doors Length Height Window Windows  Single
o - m . (inches) (inches) {LF) {LF) (Ea) Width (Ea) (Ea) (inches) (inches) (LF) {Ea)  Pane (Ea)
Sonolastic® et Tyr minimurm 25 years buildingsystems.basf.com
Tremco Sprectrem 2 High-Perfarmance Silcone Sealant n/a minimurm 20 years w.tremcosealants.com
36 24 20 4 2 1/8 2
Sealeze Nylon Therm-L- Brush Door Swee _ /2 d e teating AlS| 12 80l ca 0 0 | 68 |1466] 2 1
Sealeze Astra-Swesp Nylon TROJ 1 T ol IR 4] [1) -
- - ) ) - 2| 18.66 2 2 1a | 1| 2
Sealeze Mylon Therm-L- E”‘ShTemperarm'e Which Heating Begins 70|°F
. . . . 36 84 20 34 2
Temperature Which Cooling Begins 72|°F
Day Operation Begins (Sundav is Dav 1) 1 |Sundav ¥ 84 2 # 2 ik 2
Day Operation Ends (Sunday is Day 1) 7 |Samrday | 2 # Envelope Improvement - Environmental Emissions Reduction
Hour Operation Begins (Hour 1 is Midnight to 1 AM) 1 (Hour
Houwr Operation Ends (Hour 1 is Midnight to 1 AM) 24 |Hour 48 84 2 18
Directional Wind Infiltration Exfiltration 80% |per cent 36 4 20 i
; ; ; =9 |z
Occupied Cooling Temperature Setpoint 72|°F 0
H . ; - c
Occupied Heating Temperature Setpoint 70|°F om0 e 3 Iy
Unoccupied Cooling Indoor Temperature Setpoint 80|°F 2| Cryogenic Research (1) 108 & 150
Unoccupted Heating Indoor Temperature Setpoint 60|°F 3| Liguefier (3] 10112 I} 2,755
Cooling Plant Efficiency 0.4 |kWiton 4 Support Facilities/Offices {4) 9,194 i 2,505
Heating Plant Efficiency 80% |per cent ©|Hectomagpets o) i : ik
= - = 6| Hydrogen Lab Control (8) 6,524 kil 1,778
Energy Cost 3kWh S 0.03950 |per KWh 7 Vehice Shop (21 8089 P 15
Fuel Energv Cost 3MMBm b 6.13000 |per MMBm 8| Warehouse (1) 4,50 20 1,158
2 of Floors i Building 2 9| Plasma Physics Research (24) 3412 16 930
Local Shelter Class (see Table 3 below) 3| Twvpical shelter used by other 10] Malntenance Shops (25} 6042 z L5
A = Effective Air Leak Area from S 2 4.64 |5 11 Daycare (26) 5,016 2 1,367
A= 2Cuve - CAKASe Ared IFoim SIWVeY, i
L = = 12| Central Utilities Plant (42) 11,646 5 313
TOTALS: 95,617 458 26,054




Why Perform an Envelope Assessment?

* Envelope improvements to save energy are simple
and low cost

* Improvements often have reasonable simple paybacks
5-12 years

* Improving the overall performance of the envelope
has impact on every other component of the buildings
systems



Envelope Improvement Benefits

* Reduction in overall energy consumption

* Increased thermal comfort - Reduction in space temperature
fluctuations leading to improved occupant comfort

* Infrastructure improvement



Mechanical Insulation




Benefits of Mechanical Insulation



Mechanical Insulation Savings compared to Electrical Lighting

Energy Conservation Option Energy Savings,
MMBtu/yr (1)

1 car, 5% increase in mpg 3.7

1 compact florescent light bulb 0.9

1 ft of insulation on 180°F pipe 0.9

1 ft of insulation on 42°F pipe 0.6



Steam Piping



Condensate Receiver



Steam / Hot Water Heat Exchanger



Hidden Opportunities




HYDRONIC HEATING PUMPS



CHILLED PUMPS




OUTDOOR PIPING



Out of Sight, Out of Mind




MOLD DAMAGE




Insulated Blankets



Comprehensive Mechanical
Insulation Reports

ENVIRONMENTAL EMISSIONS

Annual CO2 Annual CO2 Annual CO2 Annual NOx Annual NOx Annual NOx Annual CE Annual CE Annual CE
Emissions LBS | Emissions LBS Emission Emissions LBS | Emissions LBS Emission Emissions LBS | Emissions LBS Emission
Insulated Bare Reduction Insulated Bare Reduction Insulated Bare Reduction
NON-INSULATED INSULATED
Scope of Work 7
Effective
Pipe In-Line 0 Lineal Total Bare Fuel Cost| Total Bare Btu Heat Total Insulated Fuel | Total Insulated Btu
(LF)/Equip | Fittings Flange | Bonnets | Pumps | centrifugal |Air Separaters|() Footage (sq) per Year Loss per Year Cost per Year Heat Loss per Year
(sq/ft) (#) |Valves (#)| Pairs (#) (#) (#) Pumps (#) #) 5
0
913.0 193 135 34 7 0 1 0q 1,341.6 S 31,124.86 4.115E+09 S 2,953.64 3.899E+08
505.4 115 15 1 0 0 0 0 565.6 S 5,501.77 7.270E+08 S 818.72 1.079E+08
173.7 43 9 0 0 0 04
’ 199.7 S 2,148.38 2.841E+08 S 288.98 3.811E+07
3049.0 953 213 13 0 0 0 (o)8]
SYSTEM: High Pressure Steam FUEL NAME Matural Gas 5,643.99 7.447E+08
HEAT COMNTENT: 1026 BTU per cuft 233.39 1.100E+08
BARE SURFACE EMITTAMCE: 0.8 FUEL COST- 6.6 US § per Mcf . :
PROCESS TEMP: 324 deg F EFFICIENCY- 85% 269.48 3.550E+07
AMBIENT TEMP: 80 deg F OUTER JACKET MATL: Al Sewice Jackst 2,593.81 3.421E+08
WIND SPEED: 0 MPH OUTER SURFACE EMITTANCE: 0.9
IMSULATION LAYER 1 850F Mineral Fiber PIPE, Type |, C547-07 HOURS OF OPERATION: 8760 2,727.30 3.601E+08
5,287.91 6.975E+08
PIPE INSULATION THICKHESS 680.15 8 982E+07
SIZE BARE | 0.5 | 1 [ 15 ] 2 | 25 ] 3 3.5 | 4 | a5 ] 5 | 55 ] 6
1,416.90 1.867E+08
114
172 23,514.27 3.102E+09
34 14.33 3.35 2.49 1.94 1.68 1.44 1.34 1.27 1.21 1.15 Tl 1.08 1.04 ! . :
1
114 21.68 489 3.33 2.35 2.16 19 174 1.61 1.52 1.43 1.37 1.31 1.26
1112 24 54 5.51 3.36 2.66 2.1 19 175 1.64 1.54 1.47 1.41 1.34 13
2 3017 6.07 3.94 3.04 2.55 2.26 2.06 1.9 1.77 1.67 1.59 1.51 1.46
2172 36.04 7.09 453 311 2.69 24 2.2 2.02 1.89 1.79 1.69 1.62 156
3 43.34 9.06 5.36 4.02 3.34 2.91 2.61 2.36 2.19 2.06 1.93 1.84 1.76




Steam Trap Assessment

Steam Trap Evaluation Report

Trap Status Chart Overall Trap Evaluation Chart Input Data for Calculations

"OK" 18| Overall Total of Traps at Facility: 184]|Production of Steam Cost ($) 5 10.44 |5/1000 lbs
"Failed Open" 86|| Total Traps Evaluated: 125||System Efficiency (%) 80% | %
"Blocked" 21||Mumber of Failed Traps: 107 Summary

“Flooded" 0 Estimated Steam Loss: 1. 73EH06) Ibs/yr
"Qut of Service" Ol| Trap Failure Rate of Evaluated Traps: || 85.60% 2,000 |MMBETu/yr
"Mot Tested” 59 Estimated Cost Savings: 5 18,041.65 |5/yr




What is Involved?

Meeting with Facility Manager/Owner
Detailed accurate field takeoff quantities
Accurate calculations
Presentation of final report/remediation options

Remediation - Verified



Thank You

Peter Boland, CIEA, BPI, LEED GA
Energy Conservation Specialist
|-Star Energy Solutions

pboland@istarenergysolutions.com
720.788.9474
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